SBC REVISION HISTORY, ERRATA AND LIMITATIONS
Version 3.991 Public Release
Fixes
1.

Removed extraneous debugging code from Box Score updater.

Version 3.99 Public Release
Enhancements
1.
2.
3.
4.
5.
6.

Schedule Page - Added additional header area lines for user content.
Schedule Importer – Improved support for importing from League LineupÒ formatted schedules.
Added progress bar displays for additional commands.
Added Pending Notifications display to flag issues that may need correction.
Improved Box Score processing speed for summary page, web page and printing.
Improved handling of Fines category mode switching.

Fixes
1.
2.
3.
4.
5.

Game schedule web page generation - Corrected some formatting issues.
Edit Game Schedule - Fixed macro error that could occur under some conditions after Delete Game button was pressed.
SBC Toolbar incorrectly displayed as two icons wide on Excel/2011 Mac after initialization.
Formula bar and SBC Toolbar visibility was not being restored under some conditions.
Box Score processing:
a. Calculation with AB selected as display value did not work correctly. PA selection was OK.
b. Currently displayed Box Score was not being fully restored after One Step Web Site and Print operations.
c. Summary (Totals: ) line was incorrectly formatted.
d. Condition where there are stats but no line score for a game was not being reported correctly.
e. Removed extraneous updating of Game Schedule under some conditions.
f. Box Score web page did not properly show all box scores.

SBC VERSION 3.99 - KNOWN ERRATA AND LIMITATIONS
General
1. The SBC is designed to operate on US versions of Excel and may not work on some international versions, especially
non-English language versions due to major functional limitations in the underlying Excel macro engines.
2. The File / Print command will result in more than one print dialog.
3. Performance of the SBC varies on different versions of Excel. This is due to implementation differences of the various
Excel versions.
4. Closing the SBC via the Excel / Exit command, or X close buttons on some versions of Excel may result in a prompt to
save the SBC_Macros.xlm file. Answering Don’t Save will allow proper termination. Preferable to use the SBC
File/Quit Softball Calculator command. See User Manual for more details.
Toolbars and Palettes
1. The checked/unchecked state of the toolbar items on the View menu do not immediately reflect the state of the toolbars if
a toolbar is closed via a toolbar close button. They will reflect the correct states after the next SBC menu command is
executed. This is a limitation as the macros do not have dynamic access to these events.
2. On some versions of Excel on the Macintosh, some of the Excel built-in toolbars are not available. These toolbars will
appear dimmed on the View menu.
3. On Excel versions with the Ribbon UI, the SBC View menu is no longer present.
Web Page Processing
1. Relative URL addresses cannot be used if the Player Files Directory option is activated. Use addresses that result in
absolute URL’s. Otherwise, incorrect links may be generated in the player files. The SBC will test for this situation and
alert the user to correct the URL’s.
2. The save areas for web pages and HTML tables must be contiguous cell selections. This is an issue only for the File /
Save Selection As Web Page or Save Selection As HTML Table commands as they allow user selectable cell areas.
3. Graphics objects for web pages may not match the images pasted on the team worksheet if the user specifies an incorrect
file link for the web graphic or if the user modifies the graphic on screen. Printed pages are not affected.
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Windows Platform Specific
1. On some Windows versions of Excel, the SBC Help / Excel Help command is not functional. In addition, the standard
Excel Help toolbar button may not be displayed in the SBC Toolbar. To view the standard Excel Help, click on the
icon in the window or in any dialog box drag bar.
2. Dialogs with dropdown menu lists may have blank slots in the list. This is an anomaly of the Windows dialog item
processing in some Excel versions.
3. The File / Page Setup and File / Print commands may result in a macro error if executed without a printer selected
previously. This is most prevalent on the Windows platform. Solution is to insure that a printer has been selected prior to
executing either of these commands. Use the File / Printer Setup command.
4. Several dialogs have combination edit/dropdown menu items such as player names, color number/name selection. If the
user activates the dropdown menu and decides to not select one of the items, the first item in the list will be selected and
will override any user value in the edit box. This is an anomaly of the Windows dialog item processing. If this occurs, hit
the Cancel button to preserve the original value and retry the command again.
5. Occasionally on some commands, an error dialog of “Can’t Empty Clipboard” may occur. The internal operation is
usually exceuted correctly. This is a well-documented problem on older versions of Excel and other Office products on
Windows. There are a number of causes for this. The SBC attempts to bypass most of these instances. Unfortunately,
some are beyond the capabilities of the SBC to address.
6. On some Excel versions, the Help key does not get mapped to the SBC Shortcuts. The keyboard equivilent: ctl+alt+?
and toolbar button do work correctly.
7. Performance on Excel/2013 is slower than on other versions such as Excel/2010 on equivilent systems.
8. The Window menu has no function under versions of Excel with the Ribbon Interface and therefore does not appear on
the SBC menu bar.
9. The File Open command cannot be used to open additional documents under versions of Excel with the Ribbon Interface.
Double-click on the document to open it.
10. On some versions of Excel (eg: 2007, 2010), the Print Preview option results in what appears to be a hang condition with
no controls to terminate the mode. This is an anomoly of Excel. To terminate the mode, go to the Windows Task Bar,
right-click on the Excel icon, and run the End Window command. This will return control to the SBC.
11. The File / About Softball Calculator command will usually report the underlying operating system as: Windows NT
6.01 regardless of the actual operating system. This is an inherent Excel macros issue. No work-around.
Macintosh Platform Specific
1. The SBC does not work under Excel Office 2016 due to lack of critical functionality to create custom menus.
2. Performance of the SBC on most version of Excel on the Macintosh platform is inherently slower than on the Windows
platform, given similar hardware. This is an inherent limitation due to the Excel macro language implementation
differences between the two platforms.
3. The Format / Alignment, Format / Patterns and Format / Borders and equivalent toolbar buttons are disabled on the
Mac versions of Excel prior to Excel/2011 due to bugs in the underlying Excel macros.
4. The About Softball Calculator command will report the system environment as PowerPC, not Intel if the version of
Excel is running under the Rosetta PowerPC emulator (Example: Excel 2004 under OSX 10.4 on an Intel-based Mac).
5. Command progress windows are not available as modeless dialogs are not supported via the supporting Excel macros.
Alternatively, the progress is displayed in the status bar at the bottom left of the window.
Excel/2008 and 2011 Macintosh Platform Specific
Excel 2008 and 2011:
1. Starting with Excel 2008, a new Ribbon User Interface was introduced. This is a hybrid implementaion compared to the
Windows Ribbon UI. The SBC menus will still appear in the menu bar at the top of the window and the SBC toolbars
are still floating toolbars as in previous versions.
2. Many of the built-in Excel tools and functions formally available via floating toolbars have been relocated to the Ribbon
UI.
3. The SBC Team Worksheets are configured to show page breaks. On Excel 2008 and 2011, this function is broken. This
is primarily for aesthetic purposes. Printing and web page generation are not affected There is no workaround for this.
4. When prompted for file or directories, the previously used directory location is not preserved. There is no workaround
for this.
5. When executing commands that take a fair amount of time to execute, the contents of the window may appear to jump or
flash. This is cosmetic only.
6. A script menu is displayed on the custom SBC menu bar. The SBC cannot block this.
Excel 2011 Only
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1.
2.
3.

The Formula button on the SBC toolbar is disabled as the supporting macros under XL2011 are broken. Use the
button on the Excel quick function toolbar instead.
The cursor does not always switch to a Watch cursor during command execution.
During operations that require selection of a file or directory (eg: One Step Web Site), the directory defaults to the
location where the SBC was launched.

Excel 2008 Only
1. The SBC custom toolbars are not available (limitation in XL2008 macros). Use the equivilent menu commands instead.
2. The SBC Team Worksheets are normally configured for display in Page Break Preview mode. This mode is not
available. The button for Normal View located at the lower left corner of the window must be selected manually for
proper SBC operation.
3. On Excel 2008, custom content area graphics are not supported.
Working with non-SBC documents is supported. However, switching windows must be done via the Window menu in order to get
the menus and toolbars to switch correctly.

REVISION HISTORY FOR PREVIOUS VERSIONS
Version 3.98 Public Release
Fixes
1.
2.
3.
4.
5.
6.
7.
8.
9.

File / Convert Worksheet format command a. Command was not functional in Version 3.97 release
Dialog and alert boxes weren’t centered when running under some versions of Excel on Windows.
SBC Toolbar
a. The first option in the list from the System and Command Summary Info tool could not be executed.
b. The General Preferences option from the Edit Preferences tool could not be executed.
Edit Schedule command – Added detection and user alerts of some additional entry error conditions.
Fixed incorrect window positioning problems on launch under some versions of Excel on Windows.
Fixed hidden zoom slider problem on launch under some versions of Excel on Windows.
Fixed incorrect dialog box centering problems under some versions of Excel on Windows.
Fixed additional stability issues running under Excel/2011 on Mac OS X.
Fixed some dialog box labels that displayed truncated on some Windows versions of Excel.

Version 3.97 Public Release
Enhancements
1.

Game Schedule Manager a. Added Edit / Game Number. Allows renumbering of a single game or resequencing of all game numbers with
variety of options.
b. Added Game Schedule Analyzer to check validity of schedule entries (eg: duplicate game numbers, duplicate
entries with same Date and Time, etc). Invoked any time schedule has been modified either manually or via
import. Can be invoked manually as well.
c. Added File / Export Schedule for calendar apps such as gCal, iOS Calendar, Outlook, etc.
d. Added computation of Main Team Streak (Wins, Losses or Ties) to Schedule Page summaries.
e. Enhanced Edit Schedule command dialog box processing.
f. Schedule importer now allows team opponent notation of ‘@’ as well as ‘at ‘ to denote an away game.

2.

User Interface –
a. Enhanced SBC Toolbar with additional commands and custom icons.
b. Added progress completion percentage display to long commands (eg: One Step Web Site ). Appears on-screen
in new Progress box (under Windows Excel versions only) or in Status Bar (Mac OS X Excel versions).
c. Added online SBC Help / SBC Revision History display command.
Division Standings –
a. Added user display control of Games Behind Leader in the Division Standings. Useful to turn off if the
standings are kept as WLT records against the Main Team (eg: Auto Update Division Standings From
Schedule mode).
Roster Management –
a. Added option to Consolidate Expansion Roster player entries during stats importing operation (Multi-Season
Mode).
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3.

4.

5.
6.
7.

b. Added Previous Player Stats area command to Select menu.
Box Score stats option selections now check for duplicates.
Enhanced Calculate/ Batting Leaders dialog box options.
Overall performance and stability improvements.

Fixes
1.
2.
3.
4.
5.
6.
7.
8.
9.

Fixed stability issues running under Excel/2011 on Mac OS X.
User Interface –
a. Keyboard equivilent mapping for Display Previous/Next Player Stats areas were incorrect.
b. Quit of SBC caused an incorrect save of the SBC_Macros file on some versions of Excel.
Box Score a. Team batting average in Box Score was incorrectly calculated if Plate Appearances option was selected.
b. Box Score user selectable stats options weren’t properly saved under some conditions.
Game Schedule Manager –
a. Schedule display wasn’t getting updated under certain conditions.
b. Schedule Manager wasn’t blocking non-integer game number parameters correctly.
Corrected parameter checking and calculation of default values in Calculate/ Batting Leaders dialog box options.
Calculate / Division Standings command incorrectly showed a date of Jan 01 in the Division Standings display if the
user had entered a blank value for the date in the command dialog options box.
One Step Web Site might crash building the game schedule web page under some conditions.
Commands that traversed the rosters in the reverse direction didn’t work properly under some roster boundary
conditions.
On startup, previous size of Team Worksheet window is maintained from previous session.

Version 3.96 Public Release
Enhancements
1.
2.
3.
4.
5.
6.

Added ability to traverse rosters in reverse direction for player selection during player-related commands.
One Step Web Site: Modified web page generation to speed up web page load times.
Improved message bar display of game counts.
Improved Game Schedule Manager processing.
Improved roster import file validity checking.
Added status indicator on Schedule page and Edit Schedule command if an entry has player stats but no schedule entry.

Fixes
1.
2.
3.
4.
5.
6.
7.
8.

Fixed instability and crash issues when running under Excel 2011 on the Mac.
Corrected false prompt to save the SBC_Macros.xlm file on some versions of Excel when quitting the SBC.
Corrected automatic updating of Next Game in Notices area.
Corrected problem where file importing did not allow all file types to be selected (older versions of Excel on Mac
platform only).
When starting an Update Player Stats session, the game number now correctly defaults to the number of games played
by the Home Team.
Posted processing date in footer area (Updated: mm/dd/yyyy) on player stats pages was incorrect under some conditions
during One Step Web Site processing.
Corrected comands that did not properly test conditions to prompt the user to update the Leaders or Box Scores.
Corrected conditions where the repeat last command entry was getting cleared out incorrectly to Can’t Repeat.

Version 3.95 Public Release
Enhancements
1.
2.
3.
4.
5.

Added on-line SBC User Manual from SBC Help menu
Added Display / Box Score command to recall a specific game to the Summary Page
Added additional conditions to prompt the user to update the Leaders/Box Score when changes to the stats might cause
them to be incorrect.
Print command enhanced to allow selective printing of each major stats area.
SBC Support and Donate to SBC Development commands now invoke the applicable page at the SBC Web Site.
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Fixes
1.

Under some conditions, the current selected Box Score display wasn’t restored on the Summary Page after the Box Score
web page was processed.
2. Web and print options to "Show Completed Games Only" didn’t include games that had a line score entry but no stats.
3. Update Player Stats command did not show the correct default game number under some situations.
4. Import Stats comands would alert the user to update the batting leaders even if no stats were imported.
5. Import Schedule would interpret a blank opponent name entry as a zero and incorrectly create a bad division team name.
6. Edit / Custom Hyperlink command flushed the clipboard contents prior to displayed the dialog box. This prevented
copy/paste of a URL from an external source.
9. Custom hyperlinks that had id= embedded in the URI where incorrectly interpreted as an anchor ID field.
10. Erroreous macro error with message “Can’t Enable Built-in Commands” would occur occasionally. This was mostly
when running under Excel/2011 on the Mac.
11. Corrected automatic posting of Next Game in Notices block if Time, Field, or Opponent were not defined.

Version 3.94 Public Release
Enhancements
1.
2.
3.

Improved import and export commands file handling.
The Schedule Manager Highlight Next Game feature now posts the next unplayed game details in the Notices block.
Added keyboard shortcut to refresh the Game Schedule and Results prior to display.

Fixes
1.

2.

3.
4.

Division Standings a. Game number totals in Team Summary wasn’t getting updated correctly when Division Standings was updated.
b. Changing the Main Team Name selection didn’t update the highlighting for that team in the Division Standings.
c. Highlighting of the Main Team Name in the Division Standings incorrectly cleared under some situations.
Export Roster a. Export Roster command did not map player names format from lastname, firstname syntax to firstname
lastname under all conditions.
b. Export Roster command did not create a unique filename under certain conditions.
Game Schedule –
a. Schedule highlighting of games with no line score marked a game as Not Reported instead of To Be Played if the
schedule date is todays’ date.
Misc –
a. Fixed window flashing that occured during import operations.
b. Fixed some incorrect command repeats.
c. The Main Team Name couldn’t be modified if there were game matchups present in the schedule.
d. Corrected some conditions where incorrect text colors were generated on web pages.

Version 3.90 Public Release
Enhancements
1.
2.
3.
4.

5.
6.
7.

Added stats validation during import operations
Added option to automatically update the Division Standings whenever schedule game results have changed.
Improved cleanup of Division Standings whenever teams are added or deleted.
Game Schedule –
a. Added option to automatically update the Division Standings whenever schedule or game results have changed.
b. Added support of additional schedule import file formats
c. Added display of team WLT record, averge runs scored/allowed, winning/losing margins
d. Enhanced processing of Mark Unplayed Games option.
Improved reporting of instances when the Box Score and/or Leaders need to be updated as a result of player stats changes
(Rename, Delete, Merge, Import, etc).
Added command Configure New Season to speed the set up for a new season.
Added command Configure New Team to speed the set up for a new team and division.
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8.
9.

Import tool enhanced to support Stats, Schedule or Roster importing.
Restructured alert message dialogs for better readability.

Fixes
Misc
1. Fixed option switching issues during Stats Importing and Roster Importing commands.
2. Fixed text truncation that occurred in some dialog boxes on Windows versions of Excel.
3. Minor bug fixes.

Version 3.80 Public Release
Enhancements
1.
2.
3.
4.
5.
6.
7.
8.
9.

Added Excel Office 2016/Windows support.
Added Game Schedule and Results Manager.
Added Repeat Last Command with keyboard shortcut for most SBC commands.
Added Edit Custom Hyperlink toolbar button and keyboard equivalent.
Added Display Next/Previous Box Score command to sequence through available box scores.
Added optional Status field for game attribute information (Box Scores and Schedules).
Added Print Selection command.
Improved printing routines to reduce number of print dialog prompts.
Added Import Roster command.

Fixes
Web Site Processing
1. Corrected problem if an oversized cell payload (contents displayed as ###) detected with non-integer formats such as
currency ($0.00).
Misc
1. Corrected printing problem of Expansion Roster stats.
2. Removed Stats Migration Tool.
3. Restructured Roster Export to always format names as firstname lastname.

Version 3.71 Public Release
Fixes
Box Score Processing
1. Previously entered line scores were not recalled correctly for box score web pages or printing. Manual recall by game
number was OK.
Misc
1. Consolidate Expansion Roster command would cause macro error fault under some conditions (Multi-Season Mode)
2. Batting leaders tie-breakers were not processed correctly under some situations.
3. Corrected web site processing problem if an oversized cell payload (contents displayed as ###) detected with non-integer
formats such as currency ($0.00).

Version 3.70 Public Release
Enhancements
Web Site Processing
1. Masthead, graphics and banner text now resizes dynamically for desktop or mobile screen sizes.
2. Enhanced masthead text banner overrides.
3. URL’s are now verified whenever a link parameter is modified and when One Step Web Site Processing is started.
4. Enhanced processing of reserved characters in player filename hyperlinks.
5. Added option to save CSS styles as a standalone .css file.
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Misc
1. Enhanced player name processing to allow selective overrides of proper name processing.
Fixes
Web Site Processing
1. Option to create a hyperlink to the site webmaster created an incorrectly formatted email address in some instances.
2. Navigation links were not created correctly under some instances when the Player Files Directory option was active.
3. Fixed syntax for masthead and navigation bar gradients.
4. Player hyperlinks in Box Score and Leaders can corrupt User Defined Hyperlinks under some conditions. Solution is
Player hyperlinks in Box Scores and Leaders are no longer supported. Player hyperlinks from Team Summary area still
supported.
5. Web Masthead Preferences command – Clicking on masthead Position check box caused dialog box to close.
6. Web Graphics Info command caused macro error under some conditions.
Misc
1. Adding player game stats with only one player in the roster resulted in a macro error.
2. Corrected clipped text displays of several dialog boxes.
3. Fixed some instances when running under Excel on Windows where the “Can’t Empty Clipboard” message might occur.
4. Deleting all player stats by selected game range with resequencing option did not resequence the line score game numbers
corectly.
5. Select All command did not work correctly.
6. Previous game Box Score was not restored after the Print command was run.
7. Rename Player command incorrectly reported an entry error if the Cancel button was entered.
8. Rename Player command prevented cosmetic changes to player names (eg: forced capitalization).
9. Changes to the Expansion Roster label name was not processed.
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Version 3.60 Public Release
Enhancements
Web Site Processing
1. Enhanced to produce “Responsive Design” web pages - common pages for both mobile and desktop browsers.
2. Box scores for all games with stats now shown on a composite Box Scores web page.
3. Added user options for “zebra” striping of stats (batting summary, detailed player stats, leaders, user notes, etc).
4. Restructured Web Page Composer and One Step Web Site Preferences commands for ease of use.
5. Improved parameter validation.
6. Added run-time options for user modification of the web site update date that will be shown in the page footer area and
optional template file generation.
7. Added option to include a hyperlink to the site’s webmaster via a user-defined email address.
8. Added user option to block web bots from indexing web pages.
9. Web page file extension types are now set automatically.
10. Improved User Notes web page generation.
11. Enhanced template file generation to facilitate automatic style and navigation updating.
12. Added Font Family Override option.
Printing
1. Added printing of all game line and box scores.
2. Added user option to suppress printing of the top banner to save ink.
3. Batting Leaders printing compacted by removing excess blank lines.
4. Added File / Printer Setup command to allow printer selections from within the SBC (Windows platforms only).
Stats Importer
1. Updated the mobile stats file importer to accept latest iScore Baseball® file formats.
Misc
1. Added ability to use the Excel Formula Bar for easier editing of non-protected cells.
2. Added additional keyboard mapping to traverse the player stats area by using PAGE UP, PAGE DOWN and END keys.
3. Added additional keyboard mapping with modifier keys for the HOME key.
4. Added Format / Restore Column Widths command to restore widths to pre-determined values.
5. Added Format / Number command for use in the User Notes area.
6. Added styling option to highlight stats category column labels. User controllable. Visible on printed and web pages.
7. Added styling option to globally change the base text color.
Fixes
Printing
1. Corrected problem of incorrect player stats and extraneous blank pages generated when printing.
2. Corrected problem that caused type size on printed pages to be very small.
Web Page Processing
1. Some WPC URL parameters were not completely verified.
2. Corrected problem that caused incorrect player stats web file names to be created if the player name syntax of “first last”
is used.
3. After editing a previous user-defined hyperlink, the actual hyperlink was updated correctly but the updated value would
not display properly in the “comment” box.
4. Masthead gradient control did not disable the gradient if the option was unchecked.
5. Word wrapping of long text lines was not processed correctly.
6. Display Computed URL’s command crashed if the check box for Include File Processsing was changed during the
dialog box display.
7. The user-defined footer did not appear in the page footer under all conditions.
Stats Importer
1. Under some situations after an SBC file import, the Importer Summary dialog would erroneously report that statistics for
a season were over-written in the target file when they were actually new statistics.
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Misc
1. Launching the SBC from the macros file caused a macro error on some Windows/Excel versions.
2. The first game line score entry for the home team got corrupted if the One Step Web Site command was ever run. An
alert will occur on launch and when the box score command is run with the instructions to correct this. This only needed
to be performed once.
3. Batting Leaders did not handle overflows and tie-breakers correctly.
4. When multiple worksheets are active, some window conditions would cause a macro error.
5. Select / User Notes Area command incorrectly scrolled to Page 1 instead of User Notes area.
6. Some toolbar item pressed/not pressed states were not getting updated under some conditions.
7. The Format User Notes Area did not work correctly if the General format was selected.
8. Fixed inability to copy/paste across windows on some Excel versions on Windows platforms.
9. File / Open command caused a macro error if the file could not be properly opened.

Version 3.50 General Release
Enhancements
Web Page Processing
1. One Step Web Site Processing Summary statistics now includes full date and time of creatation of the web site files.
Any missing graphics links and overlength cells indicators are also flagged.
Fixes
1.
2.
3.
4.
5.
6.

The SBC would crash under certain conditions on startup when running under Excel 2008 on the Macintosh.
Changing the display state of the SBC toolbar or restoring it left the team worksheet unprotected.
Launching the SBC from the SBC_Macros.xlm file caused a macro error trying to restore window positions.
Purging all player stats commands resulted in incorrect Batting Leaders and Box Score display under some conditions.
Purging all player stats caused a macro error if the game number resequencing option was selected.
Hyperlinks to individual player stats pages weren’t being created correctly under some circumstances.

Version 3.40 General Release
Enhancements
Web Page Processing
1. Custom cell hyperlinks now have the option of opening a new window when clicked.
2. One Step Web Site Processing Summary now shows processing date and web site type.
Misc
1. Non-SBC documents can be opened via the File/Open command or by double-clicking on a file after the SBC has been
started. See Errata section below for limitations under certain versions of Excel.
2. Added keyboard shortcut (Windows: ctl+alt+Q Mac: cmd+option+Q) to Quit the SBC.
3. The stats importer now checks for an attempt to import a full-stats file into a slow-pitch only file and allows for automatic
correction.
4. Added Consolidate Expansion Roster command for maintenance in Multi-Season Mode.
Fixes
1.
2.
3.
4.
5.

Custom cell hyperlinks URL’s incorrectly prepended the player files directory under some conditions.
The current cell selection was not retained after a custom hyperlink command was performed.
Keyboard shortcut for Display User Notes Page changed to alt+K to prevent protected cell error message.
Display Computed URL’s comman did not show correct directory processing results under some conditions.
Active roster player stats were not sorted by season after a Transfer Player Stats command in Multi-Season mode.
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Version 3.30 General Release
Enhancements
Web Page Processing
1. One Step Web Site now produces detailed player stats pages for mobile devices. Pages are hyperlinked from the player
names on the mobile “Stats” page.
2. Removed instances when the screen display jumps around during One Step Web Site processing.
3. One Step Web Site command now reports processing statistics at end of command.
Single-Season Mode
1. Added Clear Player Stats By Game command.
2. All player commands that request player name now show a quick stats summary for the player in the dialog.
3. Improved progress messages during mobile stats file importing.
Multi-Season Mode
1. Processing time for SBC stats file importing has been significantly reduced.
2. Improved display of detailed player stats pages by swapping GAME and YEAR columns. Applicable to screen display,
web pages and print.
3. Added display of total number of seasons for the team in Batting Summary area and for Expansion Roster players.
4. All player commands that request player name now show a quick stats summary for the player in the dialog.
User Interface
1. At startup, the screen display mode (Page Break Preview or Normal View) is automatically activated on all versions
except Excel 2008 on the Mac where it must be set manually.
2. At startup on Excel Windows versions with the Ribbon interface, the Add-ins tab is automatically activated for access to
the SBC menus and toolbars.
Misc
1. Added Display / Import Stats Summary and Display / One Step Web Site Summary commands.
2. Added keyboard equivilents for menu commands: Display/Batting Leaders and Display/User Notes.
3. SBC and Mobile stats importer commands now report processing statistics at end of command.
4. Improved roster size optimizations.
5. Overall speed improvements.
Fixes
1.
2.

Mobile Stats File Importer - Corrected the count of new roster players processed shown in the processing summary.
When running under Excel/2011 on the Mac or on Windows versions with the Ribbon Interface, the SBC Toolbar was not
deactivated during long routines.
3. On Windows versions with the Ribbon Interface, the SBC Toolbar might appear when Excel is opened with documents
other than SBC worksheets.
4. On Windows versions without the Ribbon Interface, user changes to the location or size of the SBC Toolbar were not
being saved correctly for subsequent relaunches.
5. On Windows platforms, file save and open dialogs weren’t always closing properly during long commands.
Corrected positioning of SBC dialog boxes on Windows platforms
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